How to Use ScandAll PRO

Explains about "ScandAll PRO".

Explains how to scan documents using the scanning application "ScandAll PRO".
How to Use This Manual

This section shows how to use this manual.

Cover page

Contents page

Index page

Common Note:

- To display or print this manual, either Adobe® Acrobat® (7.0 or later) or Adobe® Reader® (7.0 or later) is required.
- Clicking a blue character string (where the mouse pointer changes into a link-selecting icon such as while pointing) moves to the reference.
- In this manual, you can use the Search tool of Adobe® Acrobat® or Adobe® Reader®. For details, refer to Adobe® Acrobat® or Adobe® Reader® Help.
- On the keyboard, press the [PageUp] key to move to the previous page, and the [PageDown] key to the next page.
Introduction

Thank you for using ScandAll PRO.

Overview of ScandAll PRO

ScandAll PRO is an application that enables you to display and edit images scanned with a fi-series Image Scanner. This manual describes how to use ScandAll PRO for scanning with a fi-series Image Scanner. For details about the functions of ScandAll PRO, refer to the "ScandAll PRO Help".

Trademarks

Microsoft, Windows, Windows Server, Windows Vista, and SharePoint are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
ISIS is a registered trademark of EMC Corporation in the United States.
Adobe, the Adobe logo, Acrobat, and Adobe Reader are either registered trademarks or trade names of Adobe Systems Incorporated in the United States and/or other countries.
Kofax and VRS are trademarks or registered trademarks of Kofax, Inc.
Other company names and product names are the registered trademarks or trademarks of the respective companies.

Manufacturer

PFU LIMITED
International Sales Dept., Imaging Business Division, Products Group
Solid Square East Tower, 580 Horikawa-cho, Saiwai-ku, Kawasaki-shi Kanagawa 212-8563, Japan
Phone: (81-44) 540-4538
All Rights Reserved, Copyright © PFU LIMITED 2007 - 2010

Use in High-Safety Applications

This product has been designed and manufactured on the assumption that it will be used in office, personal, domestic, regular industrial, and general purpose applications. It has not been designed and manufactured for use in applications (simply called "high-safety applications" from here on) that directly involve danger to life and health when a high degree of safety is required, for example, in the control of nuclear reactions at nuclear power facilities, automatic flight control of aircraft, air traffic control, operation control in mass-transport systems, medical equipment for sustaining life, and missile firing control in weapons systems, and when provisionally the safety in question is not ensured.
The user should use this product with adopting measures for ensuring safety in such high-safety applications. PFU LIMITED assumes no liability whatsoever for damages arising from use of this product by the user in high-safety applications, and for any claims or compensation for damages by the user or a third party.
## Conventions

### Symbols Used in This Manual

In this manual, the following symbols are used to describe operations as well as indicate warnings.

- ! This symbol alerts operators to particularly important information. Be sure to read this information.
- ✔ This symbol alerts operators to helpful advice regarding operation.

### Abbreviations Used in This Manual

The following abbreviated terms used in this manual are described.

<table>
<thead>
<tr>
<th>Product</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® XP Home Edition (Service Pack 2 or later)</td>
<td>Windows XP</td>
</tr>
<tr>
<td>Windows® XP Professional (Service Pack 2 or later)</td>
<td>Windows (*1)</td>
</tr>
<tr>
<td>Windows® XP Professional x64 Edition</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2003 R2, Standard x64 Edition</td>
<td></td>
</tr>
<tr>
<td>Windows Vista® Home Basic (32/64-bit)</td>
<td>Windows Vista</td>
</tr>
<tr>
<td>Windows Vista® Home Premium (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>Windows Vista® Business (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>Windows Vista® Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>Windows Vista® Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2008 R2 Standard (64-bit)</td>
<td></td>
</tr>
<tr>
<td>Windows® 7 Home Premium (32/64-bit)</td>
<td>Windows 7</td>
</tr>
<tr>
<td>Windows® 7 Professional (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>Windows® 7 Enterprise (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>Windows® 7 Ultimate (32/64-bit)</td>
<td></td>
</tr>
<tr>
<td>Microsoft® Office SharePoint® Portal Server 2003</td>
<td>Microsoft SharePoint Server</td>
</tr>
<tr>
<td>Microsoft® Office SharePoint® Server 2007</td>
<td></td>
</tr>
<tr>
<td>Adobe® Acrobat®</td>
<td>Adobe Acrobat</td>
</tr>
</tbody>
</table>

*1 : Where there is no distinction between the different versions of the above operating system, the general term "Windows" is used.
Description of Successive Operations

In the procedures described in this manual, successive operations are connected with → in between.
Example: Click the [Scan] menu → [Scan Settings].

Screen Examples in This Manual

The screen examples in this manual are subject to change without notice in the interest of product improvement.
If the actual displayed screen differs from the screen examples in this manual, operate by following the actual displayed screen while referring to the user's manual of the scanner application you are using.
The screen examples used in this manual are of TWAIN driver, ISIS driver, ScandAll PRO (which is an image capturing application), and Adobe Acrobat.
The screen examples used in this manual are of Windows Vista. Depending on the operating systems you are using, the screen examples and operations may differ from the actual ones. Also note that, depending on the scanner model, screens and operations stated in this manual may differ when you update TWAIN driver/ISIS driver. In this case, refer to the manual provided upon updating the driver(s).

Scanner Component Names in This Manual

The button names on the scanner and the name of the display area of the operator panel described in this manual may differ depending on the scanner you are using.
In this case, refer to the Operator’s Guide for your scanner.
Contents

How to Use This Manual ........................................................................................................................................... 2
Introduction ........................................................................................................................................................ 3
Conventions ....................................................................................................................................................... 4

Chapter 1 Overview of ScandAll PRO .................................................................................................................. 8
1.1 What is ScandAll PRO? ........................................................................................................................................ 9
ScandAll PRO ........................................................................................................................................................ 9
1.2 Features ......................................................................................................................................................... 10
Feature of ScandAll PRO .................................................................................................................................. 10

Chapter 2 How to Use ScandAll PRO .............................................................................................................. 11
2.1 Launching ScandAll PRO ............................................................................................................................. 12
2.2 Selecting a Scanner Driver ........................................................................................................................... 13
2.3 Selecting a Scanner Model ............................................................................................................................ 14
2.4 Scan Parameters .......................................................................................................................................... 15
2.5 Scanning Methods ....................................................................................................................................... 16
  Scanning with [Scan] ..................................................................................................................................... 16
  Scanning with [Batch Scan] .......................................................................................................................... 16
2.6 Scanning with [Scan] .................................................................................................................................. 17
2.7 Scanning with [Batch Scan] ........................................................................................................................ 20
  Creating and Editing Profiles ......................................................................................................................... 20
  Scanning Documents .................................................................................................................................. 22
2.8 Advanced Scanning .................................................................................................................................... 23
  Scanning Methods List ................................................................................................................................. 23
  Duplex Scanning Using the ADF Virtual Duplex Option (fi-6750S) .............................................................. 24
  Saving Scanned Images in PDF File Format ................................................................................................. 26
## Dividing a Multipage Document Using Patch Codes ................................................................. 28
## Dividing a Multipage Document Using Barcodes ................................................................. 30
## Using the Scanner Buttons to Start a Scan Quickly ............................................................... 34
## Specifying the Result of Zone OCR as a File Name .............................................................. 37
## Specifying the Result of Barcode Recognition as a File Name ............................................. 41
## Creating Saving Folders for Each Batch Scan ...................................................................... 44
## Saving Scanned Images from a Batch Scan to a Microsoft SharePoint Server .................... 46
## Restarting a Suspended Batch Scan .................................................................................... 48
## Outputting Indexing Information File and Linking with an Application .............................. 49
## Detecting Errors in the Scanned Document (fi-6800) .......................................................... 51

### 2.9 Useful Post-Scan Functions .............................................................................................. 53
- Marking Thumbnails .................................................................................................................. 53
- Saving Scanned Images to a Microsoft SharePoint Server ...................................................... 54

| Index | 55 |
Chapter 1
Overview of ScandAll PRO

This chapter describes the overview and features of ScandAll PRO.

1.1 What is ScandAll PRO? ................................................................................................................................9
1.2 Features .....................................................................................................................................................10
1.1 What is ScandAll PRO?

ScandAll PRO

ScandAll PRO is an application for scanning images, which conforms with both the TWAIN and ISIS standards. Used with a TWAIN or ISIS driver, ScandAll PRO allows you to scan a document to convert it into image data. You can also scan a document with a VRS (*1) ISIS interface. ScandAll PRO is suitable for routine task input, such as computerizing business or application forms.

*1: An application that can easily create high-quality images. VRS can also detect and automatically correct errors that may occur while scanning. For example, scanning documents containing skewed or smudged characters due to the colored or shaded effects.

- For details about the functions of ScandAll PRO, refer to the ScandAll PRO Help.
- If your scanner does not support VRS, you cannot use VRS.
1.2 Features

Feature of ScandAll PRO

ScandAll PRO has the following features:

- **Various Scan Settings**
  - Conforms with both TWAIN/ISIS standards.
  - Allows batch processing (batch scan), enabling scan operations with scan conditions, file format, and file save destination specified. You can also save the specified scan settings as a profile.
  - Has hot key controls, enabling batch scan operations with a single touch on a keyboard.
  - Allows events to be set, enabling batch scan operations with a single press of the [Scan] or [Send to] button.

- **Display/Edit/Save Functions to Meet Your Needs**
  - Shows multiple files side-by-side for comparison.
  - Allows you to edit the scanned images in various ways such as rotating, reverting, deskewing, sorting, and page-insertion and deletion. You can save the edited data as a new file, or resave it with the profile settings used for the scan.
  - Outputs both color and monochrome images simultaneously with a single scan. (When using a scanner that supports the multi-image output function.)
  - Inputs/outputs Bitmap, JPEG and TIFF files.
  - Outputs the scanned images in PDF or PDF/A file format. You can also create searchable PDF files and high-compression PDF files.

- **Other Useful Functions**
  - Automatically saves the scanned images in the specified server by linking with FTP server or Microsoft SharePoint Server.
  - Sends the scanned images as an attached file by linking with an e-mail program.
  - Classifies pages of a document in a specified unit and saves them in separate files by using patch codes or barcodes.
  - Text-recognizes scanned barcode data or a part of the image with Zone OCR, and outputs the data to the indexing information file.
  - Launches the specified application while using the output image file or indexing information file as a parameter.
  - Checks for errors in the scanned images, and if any exist, changes the background color of the target thumbnail. (fi-6800 only)
  - Marks thumbnails of the scanned images by changing the background color so that they can be easily sorted.
Chapter 2
How to Use ScandAll PRO

This chapter describes how to scan documents with the scanner using ScandAll PRO.

2.1 Launching ScandAll PRO ...........................................................................................................................12
2.2 Selecting a Scanner Driver ........................................................................................................................13
2.3 Selecting a Scanner Model .......................................................................................................................14
2.4 Scan Parameters ........................................................................................................................................15
2.5 Scanning Methods ...................................................................................................................................16
2.6 Scanning with [Scan] ................................................................................................................................17
2.7 Scanning with [Batch Scan] ....................................................................................................................20
2.8 Advanced Scanning .................................................................................................................................23
2.9 Useful Post-Scan Functions ....................................................................................................................53
2.1 Launching ScandAll PRO

1 Select the [Start] menu → [All Programs] → [Fujitsu ScandAll PRO] → [ScandAll PRO].
   ♦ ScandAll PRO starts up.
2.2 Selecting a Scanner Driver

A fi-series Image Scanner comes with two scanner drivers; a TWAIN driver that conforms with the TWAIN standard, and an ISIS driver that conforms with the ISIS standard. ScandAll PRO supports both drivers, and there is no significant difference between them. Choose one to suit your requirements.

The following explains how to select the scanner driver (switch between TWAIN and ISIS) to use with ScandAll PRO.

1. Select the [Tool] menu → [Preferences].
   ➔ The [Setup] dialog box appears.

2. On the [Scan] tab, select either of the drivers under [Device Driver].

3. Click the [OK] button to save the settings.

- In ScandAll PRO, [TWAIN] is selected by default.
- For functional details of the TWAIN driver, refer to the TWAIN Driver Help.
- For functional details of the ISIS driver, refer to the ISIS Driver Help.
2.3 Selecting a Scanner Model

You need to select a scanner to use before you scan a document. The following explains how to select the scanner.

1. Select the [Scan] menu → [Select Scanner].
   The [Select Scanner] dialog box appears.

2. Select a scanner you want to use, and click the [Select] button.
   Select the scanner model that you connected to your computer. Note that the indication of the scanner model name depends on the selected scanner driver.

**TWAIN driver:**

**ISIS driver:**
2.4 Scan Parameters

The scan parameters are configured in the scanner driver's setup dialog box.

The scanner driver's setup dialog box specifications differ depending on the scanner. For details, refer to the Operator's Guide for the scanner you are using.

1. Select the [Scan] menu → [Scanner Setting].
   - The scanner driver's setup dialog box appears.

   **TWAIN driver:**

   **ISIS driver:**

   For the configurable parameters in the respective drivers, refer to the Operator's Guide for the scanner you are using.

2. When you have completed the settings, click the [OK] button.
   - The scan parameters are configured.
2.5 Scanning Methods

There are two ways to scan documents by using ScandAll PRO.

**Scanning with [Scan]**

Use this option when scanning a small number of pages. Each time you scan documents, you may need to configure new settings as necessary, such as the file format, saving destination, and scan parameters. For details, refer to "2.6 Scanning with [Scan]" (page 17).

**Scanning with [Batch Scan]**

Use this option when scanning a large number of pages. You can save scan settings as a "profile" in advance, and scan documents according to the profile. Profiles are configured for scan settings such as the file format, saving destination, scan parameters, image processing properties, and application with which to interact. You can create more than one profile beforehand, so you do not have to configure new settings every time you scan documents. You only need to switch between profiles. For details, refer to "2.7 Scanning with [Batch Scan]" (page 20).
2.6 Scanning with [Scan]

Each time you scan documents, you may need to configure new settings as necessary, such as scan and saving parameters.

1. Load a document on the scanner.
   For how to load a document on the scanner, refer to the Operator’s Guide for the scanner you are using.

2. Select the [Scan] menu → [Scan Settings].
   The [Scan Settings] dialog box appears.

3. In the [Scan Settings] dialog box, configure various settings such as for saving the scanned images.

For information about the setting items you can configure, refer to the ScandAll PRO Help.
4 Click the [Scanner Setting] button. The scanner driver's setup dialog box appears.

**TWAIN driver:**

5 Configure the scan parameters. For the configurable parameters in the respective drivers, refer to the Operator's Guide for the scanner you are using.

6 When you have completed the settings, click the [OK] button. You are returned to the [Scan Settings] dialog box.

7 Click the [Scan] button.

When using the TWAIN driver, clicking the [Scan] button may display the scanner driver's setup dialog box. If so, you can also change the settings in the dialog box displayed. Click the [Scan] button to scan the document. Click the [Close] button when you finish scanning.

If you do not want to display the scanner driver's setup dialog box, clear the [Show TWAIN dialog before each batch scan process] check box in the [Scan Settings] dialog box.
After the document is scanned, the scanned image(s) are displayed on the ScandAll PRO window, and then saved to a file.

- If you clear the [Save to file] check box in the [Scan Settings] dialog box, the scanned image(s) will no longer be saved to a file. To save the image(s) to a file, select the [File] menu → [Save As].
- To scan documents with the same settings afterwards, select the [Scan] menu → [Scan].
- For more details about the functions and operations of ScandAll PRO, refer to the ScandAll PRO Help.

For information about scanning methods other than scanning with [Scan], refer to "2.8 Advanced Scanning" (page 23).
2.7 Scanning with [Batch Scan]

With Batch Scan, you can save various settings as profiles beforehand and then scan documents by using such profiles.

Creating and Editing Profiles

1. Select the [Scan] menu → [Batch Scan Settings].
   - The [Batch Scan Settings] dialog box appears.

2. Do the following as necessary:
   - To create a new profile:
     Click the [Add] button.
     ➔ A new profile appears in the [Profile Editor] dialog box.
   - To create a new profile based on an existing profile:
     Select a profile you want to change the settings for, and click the [Copy] button.
     ➔ The profile you selected from the profile list is displayed as a new profile in the [Profile Editor] dialog box.
   - To change the settings of an existing profile:
     Select a profile you want to change the settings for, and click the [Edit] button.
     ➔ The selected profile appears in the [Profile Editor] dialog box.
   - To delete an existing profile from the profile list:
     Select a profile you want to delete, and then click the [Delete] button.
     ➔ The selected profile is deleted.

When you create a profile, the profile is added in the profile list.
In the [Profile Editor] dialog box, configure settings for scanning and saving the scanned images.

- The profile showing [Template] at [Type] in the dialog box is a default sample profile. It cannot be used for actual scanning. Use this profile as the base of new profiles.
- When the title line of each parameter in the profile list is clicked, profiles other than [Template] are sorted.
- You can specify the initial setting values beforehand.

1. Select the [Tool] menu → [Preferences] and specify a profile name for [Initial setting for profile] on the [Scan] tab.
2. For [Batch Scan Setting], create a profile with the same name as the one you specified.
3. An asterisk (*) is displayed to the right of the profile type, to indicate that default values are used for the profile settings. When you create a new profile with the [Add] button, the profile is created with the default settings values.

When you use TWAIN driver, only [00: Current Setting] is available for [Setting File] in [Scanner Settings].

For information about the setting items you can configure, refer to the ScandAll PRO Help.

4. Click the [OK] button.
   - You are returned to the [Batch Scan Settings] dialog box.
   - Added or copied profiles by using the [Add] or [Copy] button are added to the profile list.
Scanning Documents

1. Load a document on the scanner.

2. Select a profile from the [Select the Batch Profile] dropdown list on the toolbar.

3. Click the [Start Batch Scan] button.

After the document is scanned, the scanned image(s) are displayed on the ScandAll PRO window, and then saved to a file.

- You can perform a scan by using the [Scan] menu or by configuring settings in the [Batch Scan Settings] dialog box as well. For more information, refer to the ScandAll PRO Help.
- When a batch scan is performed, the batch scan working state is temporarily saved automatically. Because only one working state is temporarily saved for each scanning profile at a time, the saved state is always overwritten with the one last used. The temporarily saved batch scan working state can be restored from the [Scan] menu → [Restore Batch Scan]. For details on how to restore a batch scan, refer to "Restarting a Suspended Batch Scan" (page 48).
- If another scan is appended, inserted, replaced, or added to the document batch, or scanned images are edited after performing a batch scan, you can save the changed contents from the [File] menu → [Save].
2.8 Advanced Scanning

Launching the TWAIN driver from ScandAll PRO allows you to scan documents by various methods. The following shows the scanning methods list.

**Scanning Methods List**

**Changing the scanning method**
- "Duplex Scanning Using the ADF Virtual Duplex Option (fi-6750S)" (page 24)

**Setting post-scan operations and processes**
- "Saving Scanned Images in PDF File Format" (page 26)
- "Dividing a Multipage Document Using Patch Codes" (page 28)
- "Dividing a Multipage Document Using Barcodes" (page 30)
- "Specifying the Result of Zone OCR as a File Name" (page 37)
- "Specifying the Result of Barcode Recognition as a File Name" (page 41)
- "Creating Saving Folders for Each Batch Scan" (page 44)
- "Saving Scanned Images from a Batch Scan to a Microsoft SharePoint Server" (page 46)
- "Restarting a Suspended Batch Scan" (page 48)
- "Outputting Indexing Information File and Linking with an Application" (page 49)
- "Detecting Errors in the Scanned Document (fi-6800)" (page 51)

**Changing the scanner's scan responses**
- "Using the Scanner Buttons to Start a Scan Quickly" (page 34)
## Duplex Scanning Using the ADF Virtual Duplex Option (fi-6750S)

The ADF Virtual Duplex option allows you to scan the front of the pages of a document first, and then scan the reverse sides in succession. It then automatically sorts these scanned pages in the correct order.

1. **Load a document face down on the ADF paper chute.**
   For how to load a document on ADF paper chute, refer to the Operator’s Guide for the scanner you are using.

2. **In ScandAll PRO, specify Duplex Scan mode.**
   - **When selecting the Scan option**
     Select the [Perform ADF virtual duplex scanning] check box in the [Scan Settings] dialog box.

   - **When selecting the Batch Scan option**
     Display the profile to be used for scanning in the [Profile Editor] dialog box. On the [Scan] tab, select [ADF (Virtual Duplex)] from [Scan Type].

   - **When using a scanner driver**
     In the [TWAIN Driver (32)] dialog box, select [ADF (Virtual Duplex)] from [Scan Type].

In the ISIS driver dialog box, you cannot configure settings for ADF virtual duplex scanning. When using this driver, go to the [Scan Settings] dialog box or use the Batch Scan option.
Chapter 2 How to Use ScandAll PRO

3 Perform a scan with ScandAll PRO.
   ❖ When the scanning is complete, a message appears to prompt you to reload the document face up.

4 Load the document face up on the ADF paper chute.
   For how to load a document on ADF paper chute, refer to the Operator’s Guide for the scanner you are using.

   When scanning the reverse sides of the pages of a document, carefully load the document so that:
   ● The document is scanned from the last page.
   ● The pages are not upside down.

5 Click the [Yes] button.

   ❖ The reverse sides of the pages are scanned.
   When the scanning is complete, the pages of the scanned document are sorted automatically.

   ● The ADF Virtual Duplex option is not available once you have selected any of the following. To use the option, change the settings in ScandAll PRO or in the scanner driver.
     - The [Output color and monochrome simultaneously] and [Sort color and monochrome automatically] check boxes on the [File format and Name scheme] tab in the [Profile Editor] dialog box.
     - Any of the [Number of Pages per Separator], [Use Patchcode-Based Job Separation Sheet], [Use Barcode-Based Job Separation Sheet], and [Use Hardware-Based Job Separation Sheet] check boxes on the [Document separator] tab in the [Profile Editor] dialog box.
     - The [Multi Image Output] check box in the [Multi Image] dialog box, which is opened by clicking the [Enable Multi Image] check box in the [TWAIN Driver (32)] dialog box of the TWAIN driver.
     - The [Split Image] and [Blank Page Skip] check boxes in the [Option] dialog box, which is opened by clicking the [Option] button in the [TWAIN Driver (32)] dialog box of the TWAIN driver.
   ● The scanned images are not sorted if the page count on the front pages differs from that on the back side.
Saving Scanned Images in PDF File Format

ScandAll PRO allows you to create PDF data easily without any special steps. By changing the compression rate, you can reduce the size of PDF data.

ScandAll PRO is recommended for scanning in color or grayscale mode.

The procedure is as follows:

1. Load a document on the scanner.
   For how to load document on the scanner, refer to the Operator’s Guide for the scanner you are using.

2. In ScandAll PRO, select the file format to save the scanned images from the following:
   - PDF File
   - SinglePage PDF File
   - PDF/A File
   - SinglePage PDF/A File

When scanning with the Scan option

Select a file format from [File Format] in the [Scan Settings] dialog box.

When selecting the Batch Scan option

Display a profile name you want to use for scanning your file in the [Profile Editor] dialog box. Select the [File format and Name scheme] tab, and then select a file format from [File Format].

A [PDF File] or [SinglePage PDF File] is saved in a format compatible with Adobe Acrobat 4.0 (PDF 1.3), while a [PDF/A File] or [SinglePage PDF/A File] saved in a PDF/A-lb format (format for an archive of digital documents based on PDF 1.4).

Selecting [SinglePage PDF File] or [SinglePage PDF/A File] creates one file per scanned image, and selecting [PDF File] or [PDF/A File] creates one file containing multiple scanned images.
3  To configure PDF-related optional settings, click the [PDF Option] button.  
   The [Output PDF File] dialog box appears.

   ![Output PDF File dialog box]

   In this dialog box, you can change the compression rate for creating a file, make searchable PDF files, and set a password to open a PDF file.

   For details about the [Output PDF File] dialog box, refer to the ScandAll PRO Help.

4  Perform a scan with ScandAll PRO.

   ScandAll PRO features the outputting of scanned images as PDF file(s), but does not officially support the function to open PDF files. You can forcibly open files, but they may not be displayed correctly, and operation may be unstable. To view PDF files, it is recommended to use an application that can open PDF files, such as Adobe Acrobat.
Dividing a Multipage Document Using Patch Codes

ScandAll PRO supports the Job Separation function using patch code sheets. This function allows you to divide scanned images of a multipage document by a specified unit without interrupting the ongoing scan, and save them respectively in separate folders. When the output file format is set to multipage PDF or TIFF, and multipage document is scanned, the pages can be divided by the specified unit and saved as separate files.

The procedure is as follows:

1. Prepare patch code sheets.
   The PDF file for use as a patch code sheet comes with two size types (A4 and Letter). Before using the patchcode-based Job Separation function, you need to select the [Start] menu → [All Programs] → [Fujitsu ScandAll PRO] → [Patch Code] → [Job Separation (A4)] or [Job Separation (Letter)], and then print the PDF file of either “Job Separation (A4)” or “Job Separation (Letter)” as many as you need.

   - Take note of the following when you print out a patch code sheet:
     - Use blank white paper.
     - Set the scaling to 100%.
     - The sheet is not recognized correctly when printed in a size smaller than the original.
     - Do not save toners.
     - The sheet is not recognized correctly if the print is too light.
     - Do not use thin paper in order to avoid bleed-through.
     - Using the same patch code sheets repeatedly may decrease the recognition accuracy due to accumulated dirt on the sheets. If the patch code sheets are not recognized correctly or get smudged, print new patch code sheets.

2. Create a new batch profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to “2.7 Scanning with [Batch Scan]” (page 20).

3. Select the [Document separator] tab, and then select the [Use Patchcode-Based Job Separation Sheet] check box.
   - To suppress the scanning of patch code sheet images, select the [Remove separation sheet] check box.
   - In Duplex Scan mode, you can disable the scanning of the back side of patch code sheet by selecting the [Remove the next page of a separation sheet] check box.
4 Insert the patch code sheets wherever you want the file/folder to separate. Load the document with the patchcode-printed sheets face down on the ADF paper chute.

5 Using the batch profile you created above, perform a batch scan. For how to perform a batch scan, refer to “2.7 Scanning with [Batch Scan]” (page 20).

Follow the procedure below to save images of a scanned document that are separated by patch code sheets, in separate folders.

1 Select the [Use the Name Rule] check box on the [File format and Name scheme] tab in the [Profile Editor] dialog box, and click the [Name Rule] button. The [Name Rule] dialog box appears.

   - [Document Counter], [Folder delimiters], [Character string 1], and [Page Counter] in [Settings applied].

   - [Document Counter] situated above [Folder delimiters] is the folder name, and the scanned images are saved in this folder.

   If [Folder delimiters] is not set, no folders are created, and [Document Counter], [Character string 1], and [Page Counter] will be the file name.

Example of saving files in folders:
When specifying [Document Counter] as folder names

```
0001image0001.jpg
image0001.jpg
image0002.jpg
...
0002image0001.jpg
image0001.jpg
image0002.jpg
...
0003image0001.jpg
image0001.jpg
image0002.jpg
...
```

When not specifying [Document Counter] as folder names

```
0001image0001.jpg
0001image0002.jpg
...
0002image0001.jpg
0002image0002.jpg
...
0003image0001.jpg
0003image0002.jpg
...
```
Dividing a Multipage Document Using Barcodes

ScandAll PRO supports the Job Separation function using barcode-printed sheets. This function allows you to divide scanned images of a multipage document by a specified unit without interrupting the ongoing scan, and save them respectively in separate folders. When the output file format is set to multipage PDF or TIFF, and multipage document is scanned, the pages can be divided by the specified unit and saved as separate files. You can create files and folders with a name that includes the document counter or the text recognized from barcode.

ScandAll PRO can detect the following types of barcodes:

<table>
<thead>
<tr>
<th>Code</th>
<th>Character set</th>
<th>Field width</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPC/EAN/JAN</td>
<td>Numbers</td>
<td>UPC:12 (UPC-A only; includes check digits) EAN, JAN: 8 or 13 (includes check digits)</td>
</tr>
<tr>
<td>CODE39</td>
<td>Numbers, alphabets, 7 symbols</td>
<td>1 to 32 (excludes start/stop codes)</td>
</tr>
<tr>
<td>CODE128</td>
<td>Full ASCII codes</td>
<td>1 to 32 (excludes check characters)</td>
</tr>
<tr>
<td>Codabar</td>
<td>4 start/stop characters, numbers, 10 alphabets and symbols</td>
<td>1 to 32 (excludes start/stop codes)</td>
</tr>
</tbody>
</table>

The following lists the barcode detection parameters:

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode height</td>
<td>10 to 30 mm / 0.39 to 1.18 inches</td>
</tr>
<tr>
<td>Barcode length</td>
<td>300 mm / 11.81 inches or less</td>
</tr>
<tr>
<td>Barcode margin</td>
<td>5 mm / 0.20 inches or more on each side of barcode</td>
</tr>
<tr>
<td>Barcode base color</td>
<td>White (This may not be recognized correctly depending on the document.)</td>
</tr>
<tr>
<td>Barcode color</td>
<td>Black</td>
</tr>
<tr>
<td>Resolution</td>
<td>200 to 600 dpi</td>
</tr>
<tr>
<td>Barcode angle</td>
<td>Horizontal and vertical</td>
</tr>
</tbody>
</table>

- If you scan a document with an undefined barcode type for this function, the document may be separated wrongly, and the scanned images may also be deleted depending on the scan settings. To prevent this, check the document carefully in advance to see if it has undefined barcodes. It is recommended that you limit the barcode types to be detected, and define the area to detect barcodes.
- Using the same barcode sheets repeatedly may decrease the recognition accuracy due to accumulated dirt on the sheets. If the barcode sheets are not recognized correctly or get smudged, print new barcode sheets.
- If the text recognized from the barcode includes any control characters and/or characters unavailable for a file or folder name, such as \, /, :, *, ?, "", <, >, |, those are replaced with "_" (underscore) in the created folder or file name.
- The barcode may not be recognized correctly depending on the document (if skewed), the scanner driver settings and/or the print status of barcodes. Operate after ensuring that the barcode is correctly recognized.
The procedure is as follows:

1. Scan a sample image for barcode recognition. For how to perform a scan, refer to “2.6 Scanning with [Scan]” (page 17) or “2.7 Scanning with [Batch Scan]” (page 20).

   ![Image created with ScandAll PRO can be used for samples.](image)

   Details of the conditions are as follows:

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Color format</th>
<th>Paper size</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 dpi or higher</td>
<td>Monochrome/8-bit Gray/24-bit Color</td>
<td>Height and width: 50 to 453 mm</td>
</tr>
</tbody>
</table>

2. Create a new batch profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to “2.7 Scanning with [Batch Scan]” (page 20).

3. Select the [Document separator] tab, and then select the [Use Barcode-Based Job Separation Sheet] check box.

   ![Profile Editor dialog box](image)

   To suppress the scanning of the image of barcode-printed sheet, select the [Remove separation sheet] check box. In Duplex Scan mode, you can disable the scanning of the back side of barcode-printed sheets by selecting the [Remove the next page of a separation sheet] check box.
4 Click the [Setup] button.
   - The [Barcode Setting] dialog box appears.

5 Click and drag to select the area to detect the barcode.
   - The selected area is displayed in shaded red.

6 After you have completed the area selection, select the [File] menu → [Exit] to save the setting contents.

   - Sample image display
     - The sample image displayed on the barcode setting window is as follows.
     - An image which has been displayed once and then saved is displayed as a sample image. If no relevant image is saved, the last image displayed on the main window is used as a sample image. If there is no image displayed on the main window, select the [File] menu → [Open] to select a sample image.
     - Bitmap or JPEG (except Progressive JPEG) files are available.

   - Barcode type
     - You can specify the barcode type to be searched for from the [Barcode] menu → [Advanced].

   - Barcode recognition results
     - You can check the barcode recognition result of the sample image from the [Barcode] menu → [Recognize Barcode].

   - To change the sample image to be shown, replace it from the [File] menu → [Open].

   - If barcode scanning performance deteriorates, limit the barcode types to be detected or narrow the barcode area to improve the scanning performance.
   - If there are multiple barcodes in the barcode detecting area, the one recognized first will be enabled.
7 Insert the barcode-printed sheets wherever you want the file/folder to separate.
Load the document with the barcode-printed sheets face down on the ADF paper chute.

8 Using the batch profile you created above, perform a batch scan.
For how to perform a batch scan, refer to "2.7 Scanning with [Batch Scan]" (page 20).

Follow the procedure below to save images of a scanned document that are separated by barcode-printed sheets, in separate folders, and name each folder with a character string recognized from the relevant barcode:

1 Select the [Use the Name Rule] check box on the [File format and Name scheme] tab in the [Profile Editor] dialog box, and click the [Name Rule] button.
   ➤ The [Name Rule] dialog box appears.

2 Set [Job separation sheet], [Folder delimiters], [Character string 1], and [Page Counter] in [Settings applied].
Using the Scanner Buttons to Start a Scan Quickly

You can perform a scan simply by pressing the [Scan] or [Send to] button on the scanner. To do this, you first need to assign your desired scanning applications to these buttons.

**Computer Settings**

1. Confirm that the scanner is connected properly to your computer, then power on the scanner.
   For how to connect the scanner to your computer, refer to the Operator’s Guide for the scanner you are using.

2. Select the [Start] menu → [Control Panel].
   - The [Control Panel] window appears.

3. Select the [Hardware and Sound] icon.
   - The [Hardware and Sound] window appears.

4. Select the [Scanners and Cameras] icon.
   - The [Scanners and Cameras] window appears.

5. Display the properties of the scanner.
   Double-click the scanner icon.

6. Select the [Events] tab, and then select the event.
   From the [Select an event] menu, select the event that you want to launch an application for.

   ![Image of [Properties] window with [Events] tab selected]

   - The following events can be selected:
     - Scan Button (when the [Scan] button is pressed)
     - Send to 1 to n (when the [Send to] button is pressed while a number (from 1 to n) is displayed on the operator panel)

   Numbers displayed on the operator panel depend on the selected scanner.
   Example: Send to 1 - 9
7 Select the application to be launched when an event occurs.
Select the [Start this program] option button under [Actions], and then select the application you want to use.

8 Click the [OK] button.
This completes the computer settings for an application other than ScandAll PRO. Then, configure settings for your scanner according to "Scanner Settings" (page 36).

9 Start up ScandAll PRO.
10 Select the [Tool] menu → [Preferences].
   The [Setup] dialog box appears.
11 Select the [Event] tab.
12 Select the action for the event you selected in Step 6, and then select a profile from the list you want to use for scanning.

You need to create the required profile beforehand. For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" (page 20).

13 Click the [OK] button.
14 Exit ScandAll PRO.
When you press the linked button, ScandAll PRO starts up, and a batch scan is executed according to the selected profile's settings.

**Scanner Settings**

- **ADF Type**

- **Flatbed Type**

- **[Scan] Button**

- **[Send to] Button**

1. **When using the [Scan] button**
   - No setting changes are needed.
   - Pressing the [Scan] button starts up the application you selected.

2. **When using the [Send to] button**
   - Press the [Function] button to change the number displayed on the operator panel.
   - Match the event set at the computer (Send to 1 to n) and the number.
   - To perform the event configured with [Send to 2], for example, display [2] on the operator panel.
   - Pressing the [Send to] button starts up the application you selected.

- **Operator panel specifications differ depending on the scanner.** For details, refer to the Operator’s Guide for the scanner you are using.

- **Depending on the scanner you are using, the profile name specified as [Send to 1 to n] in Step 12 is displayed on the operator panel. However, the profile name is not displayed correctly if...**
  - the name is set in a language that the scanner does not support (Unsupported languages are displayed with ■)
  - the name does not fit into the display range (16 characters × 3 rows)
Specifying the Result of Zone OCR as a File Name

ScandAll PRO supports the Zone OCR function. With this function, you can perform Zone OCR on a specified area of a scanned document and output the recognition result to a file. You can also use character strings recognized by the Zone OCR as a file name or folder name. This section explains how to set the character strings recognized by Zone OCR as a file name.

The procedure is as follows:

1. Scan a sample image for Zone OCR. For how to perform a scan, refer to "2.6 Scanning with [Scan]" (page 17) or "2.7 Scanning with [Batch Scan]" (page 20).

   ![Image](image.png) The image created with ScandAll PRO can be used for samples. Details of the conditions are as follows:

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Color format</th>
<th>Paper size</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 dpi or higher</td>
<td>Monochrome/8-bit Gray/24-bit Color</td>
<td>Height and width: 50 to 453 mm</td>
</tr>
</tbody>
</table>

2. Create a new batch profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" (page 20).

   ● The following resolutions are recommended for images.
     Resolution higher than 600 dpi cannot be recognized for Color/Gray.
     - Monochrome: 400/600 dpi
     - Color/Gray: 200/300 dpi

   ● The deskew function of the driver and the orientation correction filter may improve the recognition rate.
3 Select the [Filter] tab, and then select the [Enable Zone OCR] check box.

4 Click the [Settings] button.
   ⇩ The [Zone OCR Settings] dialog box appears.

5 Click and drag to select an area for Zone OCR.
   ⇩ The selected area is displayed in shaded red.

6 After you have completed the area selection, select the [File] menu → [Exit] to save the setting contents.

   ● Sample image display
   The sample image displayed on the Zone OCR setting window is as follows.
   - An image which has been displayed once and then saved is displayed as a sample image. If no relevant image is saved, the last image displayed on the main window is used as a sample image. If there is no image displayed on the main window, select the [File] menu → [Open] to select a sample image.
   - Bitmap or JPEG (except Progressive JPEG) files are available.
   To change the sample image to be shown, replace it from the [File] menu → [Open].
Chapter 2 How to Use ScandAll PRO

7 Click the [Name Rule] button on the [File format and Name scheme] tab in the [Profile Editor] dialog box. The [Name Rule] dialog box appears.

8 Set [Character string 1], [Page Counter], and [Zone OCR] in [Settings applied].

- Zone OCR advanced settings
  You can specify advanced settings for Zone OCR from the [Zone OCR] menu → [Advanced]. For information about the setting items you can configure, refer to the ScandAll PRO Help.

- Zone OCR results
  You can check the sample image Zone OCR result from the [Zone OCR] menu → [Zone OCR].

9 Load a document on the scanner.

10 Using the batch profile you created above, perform a batch scan.
    For how to perform a batch scan, refer to "2.7 Scanning with [Batch Scan]" (page 20).

Note the following when using the character strings recognized by Zone OCR as a file name.
- Up to 32 characters can be recognized.
- Illegal characters (\ / : ? " < > | , ) are replaced with "_" (underscore).
- Line feed characters are deleted.
- If outputting the single page type file, include [Page Counter] to the file name. If the page counter is not included, the file name may be duplicated.
- When multipage type files are created, the character string recognized at the Zone OCR on the top page will be used for the file name.
Confirm and correct zone OCR results.
When the [Confirm and correct zone OCRed text] check box is selected for [Zone OCR Advanced Settings], the [Zone OCRed Text Confirmation and Correction] dialog box is displayed when a batch scan is performed. You can confirm and correct zone OCR results in this dialog box.
Specifying the Result of Barcode Recognition as a File Name

ScandAll PRO supports the barcode recognition function. With this function, you can perform barcode recognition on a specified area of a scanned document and output the recognition result to a file. You can also use character strings recognized with barcode recognition as a file name or folder name. This section explains how to set a character string recognized with barcode as a file name.

The recommended resolution for an image to be used for barcode recognition is 200 to 600 dpi.

The procedure is as follows:

1. Scan a sample image for barcode recognition. For how to perform a scan, refer to "2.6 Scanning with [Scan]" (page 17) or "2.7 Scanning with [Batch Scan]" (page 20).

The image created with ScandAll PRO can be used for samples. Details of the conditions are as follows:

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Color format</th>
<th>Paper size</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 dpi or higher</td>
<td>Monochrome/8-bit Gray/24-bit Color</td>
<td>Height and width: 50 to 453 mm</td>
</tr>
</tbody>
</table>

2. Create a new batch profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" (page 20).

3. Select the [Filter] tab, and then select the [Perform barcode recognition] check box.

   The [Barcode Setting] dialog box appears.

4. Click the [Settings] button. The [Barcode Setting] dialog box appears.
5 Click and drag to select an area for barcode recognition.

![Barcode Setting Window]

- The selected area is displayed in shaded red.

6 After you have completed the area selection, select the [File] menu → [Exit] to save the setting contents.

- **Sample image display**
  The sample image displayed on the barcode setting window is as follows.
  - An image which has been displayed once and then saved is displayed as a sample image. If no relevant image is saved, the last image displayed on the main window is used as a sample image. If there is no image displayed on the main window, select the [File] menu → [Open] to select a sample image.
  - Bitmap or JPEG (except Progressive JPEG) files are available.
  To change the sample image to be shown, replace it from the [File] menu → [Open].

- **Barcode properties**
  You can specify advanced settings for barcode recognition from the [Barcode] menu → [Advanced]. For information about the setting items you can configure, refer to the ScandAll PRO Help.

![Barcode Properties Dialog Box]

- **Barcode recognition results**
  You can check the sample image barcode recognition result from the [Barcode] menu → [Recognize Barcode].

![Barcode Recognition Results Dialog Box]

7 Click the [Name Rule] button on the [File format and Name scheme] tab in the [Profile Editor] dialog box.

- The [Name Rule] dialog box appears.
8 Set [Character string 1], [Page Counter], and [Barcode] in [Settings applied].

[Character string 1], [Page Counter], and [Barcode] are used for the file name.

Note the following when using the character strings recognized with barcode recognition as a file name.
- Up to 32 characters can be recognized.
- Illegal characters (/ : ? * " < > | , ) and spaces for the top or end are replaced with "_" (underscore).
- Line feed characters are deleted.
- If outputting the single page type file, include [Page Counter] to the file name. If the page counter is not included, the file name may be duplicated.
- When multipage type files are created, the character string recognized with the barcode recognition on the top page will be used for the file name.

9 Load a document on the scanner.

10 Using the batch profile you created above, perform a batch scan.
For how to perform a batch scan, refer to "2.7 Scanning with [Batch Scan]" (page 20).
Creating Saving Folders for Each Batch Scan

If the same batch profiles are used consecutively, multiple files with the same file name are created and may overwrite the previous batch scan output file. With ScandAll PRO, in order not to overwrite the file, you can make a setting to create folders for saving image files each time a batch scan is executed.

The procedure is as follows:

1. Create a new batch profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" (page 20).

2. Select the [File format and Name scheme] tab, and then select the [Use a batch folder] check box.

3. Load a document on the scanner.

4. Using the batch profile you created above, perform a batch scan.
   - When the batch scan is executed, the [Batch Folder Name] dialog box appears.
   - For how to perform a batch scan, refer to "2.7 Scanning with [Batch Scan]" (page 20).

5. Enter a batch folder name, and click the [OK] button.

   ![Batch Folder Name dialog box](image)
   - The batch scan starts and the scanned image file is saved in the created folder with the specified name.

If the names of the batch folders include a number of 8 or less digits at the end, names are created by adding "1" to the previously specified number. In the case where adding "1" would increase the number of digits, the number returns to "1" instead.

If folder names include a number of more than 8 digits at the end, the number does not vary.

Example:

<table>
<thead>
<tr>
<th>Specified batch folder name</th>
<th>Next batch folder name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch_0009</td>
<td>Batch_0010</td>
</tr>
<tr>
<td>Batch_9999</td>
<td>Batch_0001</td>
</tr>
<tr>
<td>Batch_000000001</td>
<td>Batch_000000001</td>
</tr>
</tbody>
</table>
Example of saving files in folders:
When using folders created for each batch scan

- Saving folders
  - Batch_0001
    - image0001.jpg
    - image0002.jpg
  - Batch_0002
    - image0001.jpg
    - image0002.jpg
  - Batch_0003
    - image0001.jpg
    - image0002.jpg

...
How to Use ScandAll PRO

Saving Scanned Images from a Batch Scan to a Microsoft SharePoint Server

With ScandAll PRO, you can perform a batch scan and save the scanned image file to a Microsoft SharePoint server.

The server on which Microsoft SharePoint Server is run requires some ScandAll PRO modules to be installed. In order to install the modules in a server, obtain "ScandAllPROSrv.exe" from the [ScandAll] folder in the Setup DVD-ROM, and execute it on the server.

The procedure is as follows:

1. Create a new batch profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" (page 20).

2. Click the [Linking] tab, and select the [Link up with the following process] check box.

3. Select [Upload to Microsoft SharePoint Server] and click the [Setup] button. The [Information to transfer to the SharePoint Server] dialog box appears.

4. Specify the settings for saving the scanned images to the Microsoft SharePoint server.

5. Click the [OK] button. This returns to the [Profile Editor] dialog box.
6 Load a document on the scanner.

7 Using the batch profile you created above, perform a batch scan.
   When the batch scan is executed, the image file is saved in the Microsoft SharePoint server.

For more information, refer to the ScandAll PRO Help.
Restarting a Suspended Batch Scan

With ScandAll PRO, when a "batch scan" is performed, the batch scan working state is temporarily saved automatically if you want to restart the batch scan, select the [Scan] menu → [Restore Batch Scan] for the saved batch scan working state. After restoration, you can restart the scanning. For example, you can continue the interrupted batch scan the next day. Similarly, if another more urgent scan needs to be performed while a batch scan is running, its working state can be saved, allowing it to be restarted at a later time.

The procedure to restore the saved batch scan working state is as follows:

1. Select the [Scan] menu → [Restore Batch Scan]. The [Saved batch scan data list] dialog box appears.
2. Select a batch scan you want to restore, and click the [Restore] button.

The working status of the selected batch scan is restored on the main window. You can perform additional operations for the batch scan, such as additional scanning or image editing.

For more information, refer to the ScandAll PRO Help.
Outputting Indexing Information File and Linking with an Application

With ScandAll PRO, you can output the result of Zone OCR and the barcode recognition result to the indexing information file. You can specify an application to be launched and a parameter to pass the name of the indexing information file to the application.

This function allows you to create a batch profile, such as for saving image data with indexing information in the server.

The procedure is as follows:

1. Create a new batch profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" (page 20).

2. Set the barcode or Zone OCR in the [Profile Editor] dialog box. For details on how to set a barcode, refer to "Dividing a Multipage Document Using Barcodes" (page 30). For details on how to set Zone OCR, refer to "Specifying the Result of Zone OCR as a File Name" (page 37).

3. In the [Profile Editor] dialog box, select the [Linking] tab, and then select the [Output indexing information] check box. To set the file name and file type to be output, click the [Set Indexing Info] button, and set in the [Set Indexing Info] dialog box.

Indexing information files are saved in the folder specified with [Folder Name] in the [File format and Name scheme] tab, in the [Profile Editor] dialog box. When the [Use a batch folder] check box is selected, indexing information files are output to the batch folder.

Indexing information files are of the following types. For information about the details of file types, refer to the ScandAll PRO Help.
- Unicode Text format

```
YYYY/MM/DD hh:mm:ss [TAB] file name [TAB] page number [TAB] "Zone OCR recognition result" [TAB] "barcode recognition result"
```

- CSV format

```
"YYYY/MM/DD hh:mm:ss", "file name", "page number", "Zone OCR recognition result", "barcode recognition result"
```
In the [Profile Editor] dialog box, select the [Link up with the following process] check box on the [Linking] tab, and then select the [Launch another application] option button. Click the [Setup] button, and specify the application to be launched for [Application Program] and %i for [Argument-Parameter] in the [Option] dialog box.

Load a document on the scanner.

Using the batch profile you created above, perform a batch scan.

After the document is scanned, ScandAll PRO launches the application and passes the indexing information file name to the application as a parameter.

For how to perform a batch scan, refer to "2.7 Scanning with [Batch Scan]" (page 20).
Detecting Errors in the Scanned Document (fi-6800)

If an error is detected in the scanned document, the background color of the thumbnail changes automatically so that the user can recognize the target image easily.

The procedure to set the automatic error detection and notification is as follows:

1. Create a new batch profile in ScandAll PRO, and then open the [Profile Editor] dialog box. For how to create profiles, refer to "2.7 Scanning with [Batch Scan]" (page 20).

2. On the [Scan] tab, select the [Mark pages when error is detected by Automatic Image Quality Checker] and [Mark pages when multifeed is detected] check boxes, and click the [OK] button.

- When selecting the [Mark pages when error is detected by Automatic Image Quality Checker] check box
  The scanned document is checked for any folds or tears. If an error is detected, it is indicated by changing the background of the thumbnail for the page containing the error to yellow.

- When selecting the [Mark pages when multifeed is detected] check box
  The scanned document is checked for any errors where multiple pages are fed at a time or where sheets of different lengths are fed. If a multifeed error is detected while scanning, the scan is continued without stopping. After all scans are completed, the multifeed error is indicated by changing the background of the thumbnail for the page containing the error to red.

3. Click the [Detail Scanner Settings] button on the [Scan] tab to configure the scan parameters.

- When selecting the [Mark pages when error is detected by Automatic Image Quality Checker] check box

<table>
<thead>
<tr>
<th>Scanner driver</th>
<th>Settings</th>
</tr>
</thead>
</table>
| ISIS driver    | Configure the parameter as either of the following:  
  - Select [Automatic], [Deskew], or [Long Page] for [Cropping] on the [Main] tab.  
When selecting the [Mark pages when multifeed is detected] check box

---

<table>
<thead>
<tr>
<th>Scanner driver</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>TWAIN driver</td>
<td>On the [Job/Cache] tab in the [Option] dialog box displayed by clicking the [Option] button, select [Check Overlapping (Ultrasonic)], [Check Length], or [Check Overlapping and Length] for [Multifeed Detection].</td>
</tr>
</tbody>
</table>

4 When you have completed the settings, click the [OK] button.
   ♦ This returns to the [Profile Editor] dialog box.

5 Click the [OK] button in the [Profile Editor] dialog box to add the profile.

6 Load a document on the scanner.

7 Using the batch profile you created above, perform a batch scan.
   ♦ If there is an error in the scanned document, the target thumbnail is displayed with background of a different color.

You can replace a scanned image with an error by selecting the [Page] menu → [Replace] → [Scan].

Depending on the color or shape of the document, errors may be detected by mistake or fail to be recognized, since they are detected only in the corners of the scanned image. Make sure to check the scanned image yourself even when you use this detection function.
2.9 Useful Post-Scan Functions

Marking Thumbnails

This function is useful to distinguish a certain desired image from others.

The procedure is as follows:

1. Load a document on the scanner and perform a scan.
2. Select the thumbnail of the desired image, and then select the [Mark] menu → [Mark].
   - The background of the selected thumbnail turns to orange.

3. After marking the desired image, select an option from the following:

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Used to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous Marked Page</td>
<td>Display the previous marked page.</td>
</tr>
<tr>
<td>Next Marked Page</td>
<td>Display the next marked page.</td>
</tr>
<tr>
<td>First Marked Page</td>
<td>Display the first marked page.</td>
</tr>
<tr>
<td>Last Marked Page</td>
<td>Display the last marked page.</td>
</tr>
<tr>
<td>Unmark</td>
<td>Unmark the selected thumbnail.</td>
</tr>
<tr>
<td>Unmark All</td>
<td>Unmark all thumbnails.</td>
</tr>
</tbody>
</table>

   You can also unmark a thumbnail by right-clicking and selecting [Unmark Selected Pages] while the thumbnail is selected.

You can also mark a thumbnail with orange background by right-clicking and selecting [Mark Selected Pages] while the thumbnail is selected.
Saving Scanned Images to a Microsoft SharePoint Server

You can save scanned images to a Microsoft SharePoint server.

Scan to Microsoft SharePoint needs to be installed. If not, install it referring to [Readme] from the [Start] menu → [All Programs] → [Fujitsu ScandAll PRO].

The procedure is as follows:

1. Load a document on the scanner and perform a scan.
2. Select the [File] menu → [Send] → [Microsoft SharePoint]. The [Scan to Microsoft SharePoint] dialog box appears.
3. Save the scanned images to the Microsoft SharePoint server.
   For more information, refer to Scan to Microsoft SharePoint User Guide.
   You can view Scan to Microsoft SharePoint User Guide by selecting the [Start] menu → [KnowledgeLake] → [Scan to Microsoft SharePoint User Guide].
# Index

<table>
<thead>
<tr>
<th>A</th>
<th>advanced scanning .......................................................... 23</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>batch scan ...................................................................... 44</td>
</tr>
<tr>
<td>C</td>
<td>conventions ...................................................................... 4</td>
</tr>
<tr>
<td></td>
<td>creating and editing profiles ........................................ 20</td>
</tr>
<tr>
<td>D</td>
<td>dividing multipage document</td>
</tr>
<tr>
<td></td>
<td>barcode ......................................................................... 30</td>
</tr>
<tr>
<td></td>
<td>patch code ..................................................................... 28</td>
</tr>
<tr>
<td></td>
<td>driver</td>
</tr>
<tr>
<td></td>
<td>ISIS ............................................................................. 13</td>
</tr>
<tr>
<td></td>
<td>TWAIN ........................................................................... 13</td>
</tr>
<tr>
<td>F</td>
<td>features .......................................................................... 10</td>
</tr>
<tr>
<td>H</td>
<td>how to use</td>
</tr>
<tr>
<td></td>
<td>ScandAll PRO .............................................................. 11</td>
</tr>
<tr>
<td></td>
<td>this manual .................................................................... 2</td>
</tr>
<tr>
<td>I</td>
<td>indexing information file ............................................. 49</td>
</tr>
<tr>
<td></td>
<td>introduction ................................................................... 3</td>
</tr>
<tr>
<td>L</td>
<td>launching ScandAll PRO .................................................. 12</td>
</tr>
<tr>
<td>M</td>
<td>Microsoft SharePoint server ........................................... 46, 54</td>
</tr>
<tr>
<td>P</td>
<td>PDF ............................................................................... 26</td>
</tr>
<tr>
<td></td>
<td>post-scan functions ...................................................... 53</td>
</tr>
<tr>
<td>R</td>
<td>restarting batch scan ..................................................... 46</td>
</tr>
<tr>
<td></td>
<td>restoring batch scan ...................................................... 48</td>
</tr>
<tr>
<td>S</td>
<td>saving folders ................................................................ 44</td>
</tr>
<tr>
<td></td>
<td>scan ............................................................................. 16, 17</td>
</tr>
<tr>
<td></td>
<td>Scan button ..................................................................... 34</td>
</tr>
<tr>
<td></td>
<td>scan parameters ........................................................... 15</td>
</tr>
<tr>
<td></td>
<td>scanning methods .......................................................... 16</td>
</tr>
<tr>
<td></td>
<td>scanning methods list ..................................................... 23</td>
</tr>
<tr>
<td></td>
<td>scanning with</td>
</tr>
<tr>
<td></td>
<td>[Batch Scan] ................................................................. 16, 20</td>
</tr>
<tr>
<td></td>
<td>[Scan] ........................................................................... 16, 17</td>
</tr>
<tr>
<td></td>
<td>selecting</td>
</tr>
<tr>
<td></td>
<td>scanner driver ................................................................ 13</td>
</tr>
<tr>
<td></td>
<td>scanner model .............................................................. 14</td>
</tr>
<tr>
<td></td>
<td>Send to button ................................................................ 34</td>
</tr>
</tbody>
</table>
Index

specifying file name
  barcode ................................................................. 41
  Zone OCR ............................................................. 37

V
  VRS .............................................................................. 9

W
  What is ScandAll PRO? ...................................................... 9
The contents of this manual are subject to change without notice.

- PFU LIMITED assumes no liability for incidental or consequential damages arising from the use of this Product, and any claims by a third party.

- Copying of the contents of this manual, in whole or in part, as well as the scanner applications is prohibited under the copyright law.